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Lesson objectives
 To learn about the different formats available for sales forms

 To save sales and purchase forms in Portable Document Format (PDF)

 To practice creating a new invoice

 To learn the purpose and use of the QuickBooks Item list

 To see how QuickBooks records the information you enter on sales forms

 To memorize an invoice transaction for reuse

 To add a new item to the Item list

 To add a new price level to the Price Level list

 To associate a price level with a customer

 To create invoice letters

 To generate reminder statements

 To create sales orders (QuickBooks Premier and higher)

 To track backorders (QuickBooks industry-specific editions)

Supporting materials
 Handout 4: QuickBooks item types

 PowerPoint file: Lesson 6

 Video tutorial: Items (products & services you sell)

 Video tutorial: Create an invoice

 Video tutorial: Generate a sales receipt

 Video tutorial: Create a statement

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

 Have Handout 4 ready for distribution.
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To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 In the Restore Backup: Method window, select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Restore Backup: To Location” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field of the Restore To window, type lesson 6 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.

Using sales forms in QuickBooks
Any time you make a sale in your business, you record it in QuickBooks on a sales form. 
A sales form can be an invoice (when you expect payment to come later), a sales receipt 
(when you expect payment at the time you make the sale), or a credit memo.

You use a credit memo when a customer returns merchandise for which you’ve already 
entered a payment or a cash sale. This lesson shows students how to use invoices and 
sales receipts.

When to use different types of sales forms

The type of sales form you use depends on whether you expect payment in the future or 
at the time of the sale.

For payment in the future

If you expect to receive payment at some future date, you enter an invoice. The invoice 
lists the customer’s name and address, along with an itemized list of how much that 
customer owes.
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To display a completed invoice form in QuickBooks:
1 Click the Create Invoices icon on the Home page.

QuickBooks displays the Create Invoices window.

2 Click Previous to display the previously created invoice.

If you own a business that sells products, like Rock Castle Construction, your 
invoice lists the products purchased by the customer, the amount charged for each 
item, and any sales tax you need to apply. Notice that Rock Castle Construction’s 
invoice charges for both products and services (such as labor).

A business that sells mainly services, such as a consulting firm, might use a different 
type of sales form than the one shown above. QuickBooks lets you choose from 
three different preset formats for your sales forms, or you can create your own 
customized forms.

3 Close the Create Invoices window.

For payment at the time of sale

If you receive full payment at the time you make a sale—either by cash, check, or credit 
card—you fill out a sales receipt instead of an invoice. Like the invoice, the QuickBooks 
sales receipt includes information about the items or services purchased, but it also 
includes information about how payment was made.
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To display a completed sales receipt in QuickBooks:
1 On the Home page, click Create Sales Receipts.

2 If the Integrated Payment Process window appears, click No Thanks or Show me 
later.

QuickBooks displays the Enter Sales Receipts window.

3 Click the Previous button to view the previously entered sale.

The sales receipt is similar to the invoice—both forms display customer 
information and describe the items and services purchased. However, because 
payment is made at the time of sale, the sales receipt has deposit information at the 
bottom of the window.

4 Close the Enter Sales Receipts window.

Using statements to bill customers

Another option for billing customers is to send statements. Statements are ideal if you 
want to accumulate charges before requesting payment, or if you assess a regular 
monthly charge. Billing statements list the charges a customer has accumulated over a 
period of time.

You enter statement charges one by one, as you perform services for the customer. Later, 
you print a billing statement that shows the previous balance, details of all new charges, 
payments received, and the new balance. Billing statements are appropriate if you want 
to send monthly statements that show the detail of new charges as well as the previous 
balance and payments received.
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If you bill the same charge to a group of customers on a regular basis, you can set up 
QuickBooks to enter the charges automatically when it's time to send out your 
statements. Any business that bills a recurring charge on statements can use this 
feature. For more information, search the onscreen Help for memorized transactions for 
statement charges.

Understanding statement limitations

In QuickBooks, statements have the following limitations:

 You can't record sales tax, percentage discounts, payment items, or group items as a 
separate charge on a billing statement. To bill for any of these, you must use an 
invoice.

 You cannot group related charges together and subtotal them (you can group and 
subtotal charges on an invoice).

 A charge on a billing statement can represent only one item (in contrast, an invoice 
can represent many items). This means you must enter a separate statement charge 
for each service or product you sell.

 You cannot add custom fields (for lists or items) to the statement form.

You can include invoice detail on statements and include all open transactions as of a 
certain date.
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Choosing a template for sales forms

QuickBooks has several different templates for invoices. The invoices available depend 
on which version of QuickBooks you are using and the type of company you set up. For 
more information, search the onscreen help for invoice template.

The templates include:

 Custom Invoice—Use this template if you want to tailor a form to your type of 
business.

 Intuit Product Invoice—Use this template if you sell parts or products and need 
fields relevant to shipping.

 Intuit Professional Invoice—Use this template if you sell services and need a lot of 
room for descriptions of your services.

 Intuit Service Invoice—Use this template if you primarily sell services but 
occasionally sell goods.

Each template has an onscreen version and a printed version. This lets you record all the 
sales detail you need, but print only what you want customers to see. For example, if you 
use the Professional Invoice template, the onscreen version shows the number of hours 
you’re billing the client as well as your hourly rate; the printed version shows only the 
Description and the Amount fields.

You can save all QuickBooks sales and purchase forms as portable document format 
(PDF) files. To save a form as a PDF file, display the form and then choose Save as PDF 
from the File menu.

You’ll learn how to customize forms in Lesson 15, “Customizing forms and writing 
QuickBooks Letters.”

Filling in a sales form
Suppose Rock Castle Construction wants to bill a customer for a portion of a kitchen 
remodeling job. Because they expect payment to be made in the future—rather than 
cash on the spot—they need to create an invoice.

Filling in the customer information

Filling in an invoice is just like filling in a paper form; you enter the customer 
information first, followed by a description of the charges.

To enter customer information on an invoice:
1 On the Home page, click Create Invoices.

Notice that the new invoice already has the current date (12/15/2007 in the sample 
file) entered in the Date field, and the next invoice number assigned in the 
Invoice # field.
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2 In the Template field, select Custom Invoice from the drop-down list.

3 In the Customer:Job field, click the arrow next to the drop-down list.

QuickBooks shows you a list of Rock Castle Construction’s existing customers and 
jobs.

4 Choose Jacobsen, Doug:Kitchen for the customer and job.

Because this name has already been entered on the Customer:Job list, QuickBooks 
knows the billing name, the address, and the payment terms. It provides this 
information for you on the top half of the form.

Filling in the line item area

On the bottom half of the invoice, you list each service or product you’re selling on its 
own line, along with the amount the customer owes for that item. Because information 
about individual items is on separate lines, the lines are called line items.

In QuickBooks, you enter line items using the Item list, so you don’t have to type and 
retype lines for services or products you sell frequently. For example, an architect would 
have one item for design and another for construction supervision.

But items are not just products you sell or services you provide to clients. Line items can 
be anything you might want to put in the detail area of an invoice, like a discount, a 
subtotal line, a markup, or a sales tax calculation.

Rock Castle Construction has already entered the items for which it bills customers on 
its Item list.
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To complete the line item area of an invoice:
1 In the Item field, type the letters rem (for Removal).

QuickFill is an alternative to choosing from a list. Whenever you’re in a field where 
you’ll use a list item, you can start typing the first letter or two of the list item you 
want, and QuickBooks fills in the field with the item that matches the letters you’re 
typing.

2 Press Tab.

When you press Tab to accept a QuickFill entry, QuickBooks fills in other
information about the item, like its description and rate. In this case, QuickBooks 
displays “Removal labor” in the Description column and a rate of $35 per hour. All 
you have to do is enter the number of hours.

3 Type 40 in the Quantity column.

4 Press Tab to have QuickBooks update the invoice total.
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Completing the sales form

If you want to check the form before you print it, you can use the print preview feature 
in the Create Invoices window.

To complete and record the invoice:
1 Click the Print Preview button at the top right corner of the screen.

QuickBooks displays the invoice page as it will look when printed.

2 Click Zoom In and use the scroll bars to see the invoice items at greater 
magnification.

3 Click Close.

4 In the Create Invoices window, record the sale by clicking Save & Close.

QuickBooks records the invoice in your accounts receivable register. If this were a sales 
receipt, QuickBooks would record the sale in your Undeposited Funds account until you 
deposit the money at the bank, or record a deposit in the bank account you specified in 
the Enter Sales Receipts window. (The option to select an account into which you want 
to deposit the payment is only available when the Sales & Customers preference “Use 
Undeposited Funds as a default deposit to account” is turned off.)

The accounts receivable register keeps track of how much money your customers owe 
you.
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To see the Accounts Receivable register:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 In the chart of accounts, double-click the Accounts Receivable account.

QuickBooks displays the accounts receivable register.

3 Select the sale we just recorded in the register (for Doug Jacobsen).

4 Double-click the entry.

When you double-click an entry in a register, QuickBooks displays the original form 
(in this case, the invoice).

5 Keep the invoice window open; you’ll use it in the next exercise.

Make sure students keep this invoice displayed on screen. You’ll show then how to 
memorize it in the next lesson.
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ip When you’ve been using QuickBooks for a while and need to find a particular invoice, 

you can use the QuickBooks Find command or the Search command. Suppose you want 
to search for the invoices you wrote to three particular customers.
Here’s how you’d find those using the Find command:

1 From the Edit menu, choose Find Invoices and then click the Advanced button.

2 In the Find window, select Transaction Type from the list of filters, and then select 
Invoice from the list of transaction types.

3 Select Name from the list of filters, and then choose Multiple names from the Name 
drop-down list.

4 In the window that appears, click the names of the three customers. When you click 
OK and then click Find, QuickBooks finds all the invoices written to those particular 
customers.

You can also find a particular customer invoice by scrolling through the customer 
register for that customer. (Right-click that customer’s name in the Customers & Jobs List 
and choose Use Register.) If you know the invoice number, you can sort the customer 
register by number rather than date to find an invoice more quickly. (You can change the 
sort order by selecting a different order in the Sort By field in the register window.)
Another way to find an invoice for a particular customer is to click Find in the Create 
Invoices window. You can then enter a customer:job name, a date range, an invoice 
number, or an amount that QuickBooks can use to locate an invoice or invoices. (This 
functionality is available for eight common QuickBooks forms.)
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Memorizing a sale
Many of the sales you make in your business are ones you repeat again and again. For 
example, you may have a standing monthly order from a customer, or you may perform 
essentially the same services for more than one client. QuickBooks lets you memorize 
sales forms so that you don’t have to retype the information.

To memorize the invoice:
1 Make sure you have the invoice you want to memorize displayed on your screen.

For this exercise, use the removal labor invoice you just created.

2 From the Edit menu, choose Memorize Invoice.

QuickBooks displays the Memorize Transaction window.

3 In the Name field, type a brief description that helps you recognize the memorized 
invoice, or keep the default description QuickBooks has provided.

You can enter any description you like. Notice that you can also have QuickBooks 
remind you when to use the memorized transaction (for an invoice you always send 
at the end of the month, for example).

4 Click OK.

5 Close the Create Invoices, Accounts Receivable, and the Chart of Accounts 
windows.

When you memorize an invoice, QuickBooks adds it to the Memorized Transaction list.
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To recall a memorized sale:
1 From the Lists menu, choose Memorized Transaction List.

QuickBooks displays the Memorized Transaction List window.

2 Double-click the transaction you just added.

QuickBooks displays the Create Invoices window, with the information you 
memorized displayed on the form. It gives you a new invoice number and displays 
the current date. You can modify the information as you wish, or just save the 
invoice as is.

3 Click Save & Close to record the invoice.

4 Press the Esc key to close the Memorized Transaction list.

Entering a new service item
When you begin using your own QuickBooks company file, you’ll need to create your 
own line items to include on your invoices. In the next exercise, you’ll see how to add 
information to the Item list.

Rock Castle Construction already has a service item called Repairs that it uses when it 
wants to charge for general repair work. Suppose Rock Castle wants to add a subitem for 
plumbing repairs to the Item list. (The company charges a higher rate for plumbing 
repairs, so it wants a separate item for it on its Item list.)

Have students refer to Handout 4 for a review of the types of items they can add to the 
Item list.
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To create a new service item:
1 From the Customers menu, choose Item List.

QuickBooks displays the Item list for Rock Castle Construction.

2 Click the Item menu button, and then choose New.

QuickBooks displays the New Item window.

Note: The options available in the Type list depend on the version of 
QuickBooks you are using. If you are using a QuickBooks Premier or higher 
edition product you will see Inventory Assembly listed as an item type.

3 In the Type field, select Service from the drop-down list.

4 In the Item Name/Number field, type Plumbing.

5 Click the “Subitem of” checkbox to select it.
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6 In the drop-down list below the “Subitem of” field, select Repairs.

7 In the Description field, type Plumbing repairs and maintenance and press Tab.

8 In the Rate field, type 55.

9 In the Tax Code drop-down list, select Non.

Now you need to assign this line item to one of Rock Castle Construction’s income 
accounts.

10 In the Account field, select Construction:Labor from the drop-down list.

Your screen should look like the following figure.

11 Click OK to add the new item to Rock Castle Construction’s Item list.

12 Close the Item list.
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Now that the new item is on the Item list, Rock Castle Construction can invoice for 
plumbing repairs separate from its general repair work. It can also create sales reports 
that show sales for general repairs separate from sales for plumbing repairs.

Using multiple price levels
In the last exercise, you set up a new service item for Rock Castle construction and 
assigned a price to that item. Sometimes businesses want to vary an item’s price based 
on who they are selling to. For example, Rock Castle Construction charges different 
prices depending on whether it is selling to a residential or a commercial customer.

You can associate price levels with specific customers so that each time you create an 
invoice (or estimate, sales receipt, credit memo, or sales order) for that customer, 
QuickBooks uses the appropriate price level when calculating rates and amounts on the 
form. Price levels make it easy to use different rates on sales forms without having to 
calculate percentage amounts manually. Price levels affect amounts for service, 
inventory, non-inventory part, and inventory assembly items only. (Inventory 
assembly items are available in QuickBooks Premier and higher.)

In this section, you’ll create a new price level, associate it with one of Rock Castle’s 
customers, and then create an invoice for that customer.

Creating new price levels

Rock Castle Construction charges its residential customers the base sales price it set up 
on its Item list. The company charges its commercial customers 10 percent less than the 
base sales price. In this exercise, you’ll create a new price level for Rock Castle 
Construction to use to reduce the sales amount for its commercial customers.

For each price level you create, you assign a name and percentage increase or decrease to 
the item’s base sales price. You can create up to 100 price levels to use on invoices, sales 
receipts, estimates, and credit memos.

As described later in the lesson, QuickBooks: Premier editions also allow you to set up 
Per Item price levels.
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ip To offer a discount on an invoice (or other sales form) at the time of sale (for example, for 

a senior discount), create a “discount” type item and enter it as a line item on the form.
If the discount is to apply to more than one item, first use a “subtotal” type item to 
calculate the total of the items. Then, enter the discount item beneath the subtotal.
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To create a new price level:
1 From the Lists menu, choose Price Level List.

2 From the Price Level menu button, choose New.

3 In the Price Level Name field type Commercial.

4 From the Price Level Type drop down list, select “Fixed %.”

Note: The Price Level Type field is selectable only with QuickBooks Premier or 
higher.

5 Leave “decrease” selected in the “This price level will” field, and then type 10 in the 
percentage field.

Always enter the percentage as a positive number.

6 From the “Round up to nearest” drop-down list, choose “1.00 minus .01.”

This option rounds all the prices to the nearest dollar amount minus one cent, for 
example, $10.00 rounds to $9.99. With QuickBooks, you can round your prices to 
the nearest whole cent, or you can precisely determine the amount by creating a 
user defined option.

Your window should look like the following.
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7 Click OK.

Your Price Level list should now resemble the following.

8 Close the Price Level list.

Associating price levels with customers

When you assign price levels to customers, QuickBooks calculates rates and amounts on 
sales forms based on the price level associated with that customer.

To associate a price level with a customer:
1 Click Customer Center on the icon bar. 

2 In the Customers & Jobs list, select Lew Plumbing - C.

3 Click Edit Customer, and then click the Additional Info tab.
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4 From the Price Level drop-down list, choose Commercial.

Your screen should look like this.

5 Click OK to close the Edit Customer window and save your changes.

Leave the Customer Center open for the next exercise.

Using price levels on sales forms

In this section, you’ll create an invoice for the customer with whom you just associated 
the Commercial price level to see how the price level affects amounts on the form.

To use a price level associated with a customer:
1 Make sure Lew Plumbing - C is selected in the Customers & Jobs list.

2 Click the New Transactions menu button and choose Invoices from the drop-down 
menu.

3 Press Tab.
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Notice that QuickBooks displays the name of the price level associated with this 
Customer:Job in brackets above the Customer:Job drop-down list. (This
information will not be printed on the form.)

4 Click in the Item column and choose Framing from the drop-down list. 

If you don’t see the Item column, make sure you are using the Custom Invoice 
template.

5 In the Quantity field, type 8.

6 Click below Framing in the Item field and choose Wood Door:Exterior from the 
drop-down list.

7 In the Quantity field, type 2 and then press Tab.

Your screen should look like this.

8 Keep the invoice open and choose Item List from the Lists menu.
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9 In the Item list, go to Framing. Note that the price for framing is $55.00, but the rate 
on the invoice is $49.99—10 percent less than the base sales price, rounded to the 
nearest dollar minus one cent. QuickBooks has automatically reduced the rate on 
the invoice by 10 percent and rounded the amount according to your price level 
setting.

Note: You can set up QuickBooks to round rates up to the nearest cent. You can 
set the rounding option for a rate from the Price Level list. See “Creating new 
price levels” on page 166.

10 In the Item list, scroll to the Wood Door:Exterior item and note that the base sales 
price is $120—10 percent greater than the rate listed on the invoice using the 
Commercial price level. It appears on the invoice as $107.99, including the discount 
and rounding settings.

11 Close the Item list.

12 Record the invoice by clicking Save & Close.

Assigning price levels to individual line items

In addition to associating price levels with customers, you can also use price levels on an 
individual basis on sales forms. The following are some examples of when you might 
want to do this.

 You’ve associated a price level with a customer, but want to charge the base sales 
price for an item on a sale to that customer.

 You want to use a price level for one or more items, but you don’t want to assign a 
price level to the customer for whom you’re recording the sale.

To apply a price to a single line item:
 In a sales form with line items, click in the Rate column and select the price level you 

want to use from the drop-down list that displays.

When you move out of that field on the form, QuickBooks recalculates the amount 
and balance due.
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Note: If you use QuickBooks Premier, you can refine your price levels even further 
by setting price levels for select items. For example, you could give a particular 
customer or group of customers an extra discount for a specific item or group of 
items as shown in the following graphic.

Reminding customers of overdue payments
In this section, you’ll learn about two types of documents you can create to remind 
customers about overdue payments.

The first method involves creating a letter to a specific customer directly from that 
customer’s overdue invoice. Using this method, you can create a cover letter that 
summarizes information about the original invoice and lists the outstanding balance. 
You can also have QuickBooks list all of the line-item information. An additional option 
is to have QuickBooks format the letters to work with window envelopes.

The second method involves generating reminder statements, which allow you to 
generate documents that list recent invoices, credit memos, and payments received.

Creating invoice letters

Rock Castle has noticed that one of its customers has an invoice with a partial balance 
still outstanding and wants to send a quick reminder. You create an invoice letter to 
remind the customer about the unpaid balance.
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To create an invoice letter:
1 From the Reports menu, choose Customers & Receivables, and then choose Open 

Invoices from the submenu.

2 In the report window, scroll down until you see the listings for Anton Teschner:Sun 
Room.

3 Double-click on the line for invoice # 60.

4 In the Create Invoices window, click the down arrow next to the letter and envelope 
icon to display the drop-down list.

5 Select Prepare an Invoice Letter.

If QuickBooks prompts you to find letters, click Copy. QuickBooks will copy the 
QuickBooks letters from your installation directory to your QBtrain folder.

6 Choose Cover Letter.

If you wanted to include all of the line-item detail from the invoice, you would 
choose the Invoice Letter with Details option.

7 Click Next.

8 Type Tom Ferguson in the Name field and then type President in the Title field.

9 Click Next.
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QuickBooks displays a letter containing summary information pulled from 
QuickBooks about the unpaid balance on the invoice.

10 You don’t need to save the letter for this exercise, so close the Microsoft Word file 
without saving.

11 In QuickBooks, click Cancel because you don’t need to print envelopes now.

12 From the Window menu, choose Close All.

To create your own custom letters that pull information from the Customers & Jobs, 
Vendor, Employee, and Other Names lists in QuickBooks, see “Using QuickBooks 
Letters” starting on page 415.

Generating reminder statements

Reminder statements summarize a customer's account with a company by listing recent 
invoices, credit memos, and payments received. You can use reminder statements when 
you bill through invoices but want to remind your customers about delinquent 
payments.

Reminder statements are different than other “forms” in QuickBooks such as invoices, 
sales receipts, or checks. Because QuickBooks already has all the information you need 
to create reminder statements, you don't have to fill them out. Instead, you review the 
information that will appear on each statement, decide whether to add finance charges, 
and print them.
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Rock Castle uses invoices to bill its customers, but it sends reminder statements to 
customers with overdue invoices. In this exercise, you generate statements to send to 
customers with outstanding balances.

Rock Castle wants to send reminder statements to all customers who have balances 
more than 30 days past due.

To generate reminder statements:
1 Click Home to display the Home page, then click Statements.

QuickBooks displays the Create Statements window.

2 In the Enter Statement Date and Type section of the window, select the “All open 
transactions as of Statement Date” option.

3 Click to select the “Include only transactions over” checkbox.

4 Leave the number of days past due field entry at 30.

5 In the Select Customers section, select “All Customers.”

6 In the Select Additional Options section, click to select the “Show invoice item 
details on statements” checkbox.
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Your screen should look like the following graphic.

7 Click Assess Finance Charges.

QuickBooks displays the Assess Finance Charges window.

8 Click Unmark All.

9 In the Assess column, click to put a checkmark in the row for the 155 Wilks job for 
Pretell Real Estate.

Your screen should look like the following graphic.
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10 Click Assess Charges.

11 Answer Yes when QuickBooks displays the message telling you that finance charges 
have already been assessed today.

QuickBooks creates a finance charge invoice for Pretell Real Estate in the amount of 
$22.08. This amount does not display on the current statement, but you can send 
the finance charge invoice with the reminder statement.

12 Click Preview.

QuickBooks displays reminder statements for the three customers whose balances 
are 30 days or more past due—including the details from the original invoices.

13 Click Close.

At this point you could generate and send the reminder statements to your 
customers.

14 Close the Create Statements window.

Processing sales orders
The sales order feature lets you track orders from customers and “set items aside.” You 
can also use sales orders to track back orders when a customer orders something and you 
are out of stock. Using this feature, you can track the orders you need to fill without 
affecting accounts receivable. Sales orders affect only inventory quantities—not 
values—until you actually sell the items.

When inventory items come in, you can create an invoice directly from the sales order. 
If only some of the items have come in, you can invoice for those items, and use the sales 
order to create invoices for the remaining items later. Once all items have been received 
and invoiced for, QuickBooks Premier closes the sales order.

Note: Sales orders are available in QuickBooks Premier and higher editions only. 
To proceed through this exercise, you must be using QuickBooks Premier or a 
higher edition.

Invoicing against sales orders

In this exercise, you’ll create an invoice from a sales order. You display a report to see if 
there are any open sales orders. The report shows that there is an open sales order for 
Lumber for Fran Smallson. Rock Castle now has sufficient quantity on hand to fill the 
customer’s order, so you can close the sales order and invoice the customer.

If you’re using QuickBooks Premier, you can also generate purchase orders directly from 
sales orders by clicking the down arrow on the Create Invoices button in the Create Sales 
Order window, and then selecting Purchase Order. You don’t need to create the 
purchase order in this exercise.
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To create an invoice from a sales order:
1 Click Report Center, choose Sales and then choose Open Sales Orders by Item.

QuickBooks displays the Open Sales Orders by Item report.

2 Double-click the sales order for Decking in the report window (Sales Order #2 for 
Fran Smallson).

QuickBooks opens the sales order.
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3 Click the Create Invoice menu button on the toolbar at the top of the Create Sales 
Orders window.

Creating the invoice from the sales order links the sales order and invoice, which 
means that when you invoice the customer for items on the sales order, those items 
are marked as closed.

QuickBooks displays the Create Invoice Based On Sales Order window.

4 Leave the “Create invoice for all of the sales order(s)” option selected, and click OK.

QuickBooks creates an invoice for the customer.

In this case, all of the items the customer order arrived, so you can close the sales 
order. If only some of the items had come in, you could invoice for only those items 
and keep the sales order open until any remaining items arrived. QuickBooks tracks 
which items are still open.

5 In the Create Invoices window, click Save & Close.

6 Close the report window and the Report Center.

Tracking backorders
Using certain industry-specific QuickBooks Editions, you can use sales orders to track 
items that customers have ordered, but that are out of stock. Tracking backorders on 
sales orders, invoices, and other sales forms shows exactly what still needs to be shipped 
out. Tracking backorders on purchase orders shows what is still expected to be received 
from a vendor.

In this exercise, you’ll first create a sales order and create an invoice from that sales order. 
(The customer has ordered items, but you don’t have sufficient quantities to fill the 
entire order.) Then, you’ll receive items into inventory and track the remaining items 
on backorder.

Note: You must be using QuickBooks Premier Accountant Edition, Retail 
Edition, Manufacturing and Wholesale Edition, or Enterprise Solutions 
Editions to track backorders and perform this exercise.
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To create a sales order:
1 On the Home page, click Sales Orders.

QuickBooks displays the Create Sales Orders window.

2 In the Customer:Job drop-down list, select Roche, Diarmuid:Room Addition.

3 Click in the Item column and select Frames:Exterior Frame from the drop-down list.

4 In the Ordered column, click the Availability icon.

In the Current Availability window, you can get information about what is available 
in inventory, what is listed on other sales orders, what’s reserved for assemblies, and 
what’s on order. 

Notice you have two exterior frames available. However, you need four exterior 
frames to complete the room addition. So you’ll need to put the remaining two on 
backorder.
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5 Click Close, and then type 4 in the Ordered column.

6 Press Tab, and then click OK at the two messages that appear.

7 Type 40.00 in the Rate column.

8 Press Tab again to have QuickBooks update the total.

The sales order should look like the following graphic.

You can fill part of the order now because you have two exterior frames in stock, so 
you’ll create an invoice from the sales order.

9 In the Create Sales Orders window, click the arrow next to the Create Invoice menu 
button on the toolbar and choose Invoice.

This links the sales order and invoice, which means that when you invoice the 
customer for items on the sales order, those items are marked as closed.

QuickBooks displays the Create Invoice Based On Sales Order(s) window.

10 Click “Create invoice for selected items” and click OK.
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QuickBooks displays the Specify Invoice Quantities for Items on Sales Order(s) 
window. When you create the invoice for selected items only, you indicate how 
many of each item from the sales order you want to include on the invoice.

Note: You can click the “Show quantity available instead of quantity on 
hand” checkbox to display the number of items in inventory plus the 
number of items on purchase orders with vendors, minus the number 
listed on all other sales orders and quantity on pending builds.
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11 Make sure 2 appears in the To Invoice column and click OK to invoice for the two 
exterior frames you have in inventory.

QuickBooks displays the invoice. The invoice lists how many of each item has been 
invoiced previously and how many are included in the current invoice.

12 Click Save & Close.

QuickBooks creates an invoice for the two door frames in stock and puts the other 
two on backorder.

The Open Sales Orders by Item report can help you track which items are on backorder 
by showing the quantity ordered and the quantity invoiced. (To run the report, go to 
the Reports menu, choose Sales, and then choose Open Sales Orders by Item.)
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Receiving items

Rock Castle Construction has just received 10 exterior door frames from 
Perry Windows & Doors. Before you can invoice Diarmuid Roche for the door frames on 
backorder, you need to receive the items into inventory.

To receive items into inventory:
1 From the Vendors menu, choose Receive Items.

2 In the Create Item Receipts window, choose Perry Windows & Doors from the 
Vendor drop-down list.

3 Click No at the message that appears.

4 In the Item column, select Frames:Exterior Frame.

5 Press Tab twice to go to the Quantity column and type 10.

6 Press Tab and QuickBooks updates the amounts.

Your screen should resemble the following graphic.

7 Click Save & Close.
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Once you’ve entered the items into inventory, you have sufficient quantity on hand to 
finish filling Diarmuid’s order. 

To fill Diarmuid’s order:
1 From the Customers menu, choose Create Sales Orders.

2 Click the Previous button to display Diarmuid’s sales order.

Notice that QuickBooks helps you track backordered items by adding a Backordered 
column to sales orders. (Backordering always starts from sales orders.) In addition, 
you’ll see Invoiced and Clsd columns. Once the sales order is either fully invoiced or 
closed, the Backorder column no longer displays. The Invoiced and Clsd columns 
always appear. 

3 In the Create Sales Orders window, click the Create Invoice menu button on the 
toolbar.

QuickBooks displays the Create Invoice Based On Sales Order window. 
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4 Click “Create invoice for selected items” and click OK.

QuickBooks displays the Specify Invoice Quantities for Items on Sales Order(s) 
window. When you create the invoice for selected items only, you indicate how 
many of each item from the sales order you want to include on the invoice.

5 Make sure 2 appears in the To Invoice column and click OK to invoice for the two 
exterior frames for Diarmuid’s room addition.

QuickBooks displays the invoice. On the invoice, QuickBooks lists how many of 
each item has been invoiced previously and how many are included in the current 
invoice.

You can customize invoices to display a Backordered column. See Lesson 15, 
“Customizing forms and writing QuickBooks Letters.”

6 Click Save & Close to save the invoice and close the Create Invoices window.
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7 On the Home page, click Sales Orders.

8 Click the Previous button to display Diarmuid’s sales order.

Notice the sales order now indicates that it has been invoiced in full.

9 Close the Create Sales Order window.

Tracking backorders on purchase orders

A backorder is the inventory on a purchase order that has not yet been received. In 
QuickBooks this occurs when a purchase order has been sent, a partial shipment has 
been received, but you have not received the final shipment. The items on the purchase 
order that have not yet been received are considered to be on backorder.

Backordered and Rcv'd columns automatically appear after a purchase order has been 
partially received.

Note: You can customize your purchase order template if you want the 
Backordered column to be printed on the purchase order.
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